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Introduction

Welcome to Bridgewater Bank’s Check Positive Pay. While the use of checks has
declined, they remain the most targeted payment type for fraudulent attacks resulting
in the largest dollar amount of financial loss. It is important for businesses to put
preventative measures in place to protect their corporate assets. Positive Pay is an
automated fraud detection tool that matches the checks a company issues with those
presented for payment. If there are any discrepancies, the business will be notified via
email of the exception to review the image via The Bridge online banking system and
can pay or return the item. Positive Pay allows businesses to reduce the possibility of
check fraud, increase control over check payments and streamline account
reconciliation.

Getting Started
General Information

e Contact the Business Services Team for technical support. They can be reached
M — F, 8:30am-4:30pm at 952.542.5100 or hello@bridge2bwb.com.

e Email notifications will be sent at 7am and again at 1lam if items have not been
resolved. If there are no exception items, no email notification will be generated.

e Decisions must be transmitted before 12pm, the day of the exception.

e |[f items have not been addressed by 12pm, the default decision defined in the
positive pay setup will be used.

e Bridgewater follows the Federal Reserve’s processing dates. You can import

items on these holiday’s, however checks will not clear and email notifications of
exceptions will not be generated until the following business day. For a most
up-to-date Federal Reserve Holiday calendar, reference
http://www.federalreserve.gov/aboutthefed/k8.htm.

e Bridgewater strongly recommends limiting access to authorized personnel only
and if possible, to separate duties. For more information on user settings needed
to establish this, contact the Business Services Team at 952.542.5100 or
hello@bridge2bwb.com.

Access Check Positive Pay

Check Positive Pay can be accessed via The Bridge’s Secure Browser.

1. After logging in to your secure browser, a Check Positive Pay tile will appear on
the Apps screen. Click on the tile to direct you to our Check Positive Pay System.
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Secured Apps For

2. If you are within The Bridge online banking, Check Positive Pay can be clicked on
from the Access Center on the Dashboard.

Good Afternoon Last logen on Jul 2, 2021 11:17 AM O

PEELLENCE  Account Information  Payments & Transfers ~ Fraud Mgmt  Administration ~ My Settings

Welcome to The Bridge

1] ACH Approvals Pending
® ® 0 ‘Wire Approvals Pending
Bill Pay Check Positive Pay 0 ACH Filter Exceptions
} 1] Check Positive Pay Exceptions

User Preferences

Preferences is an optional feature that allows you to choose your preferred default
landing page to provide quicker access to complete your daily tasks.

1. Click on your name in the right-hand corner to expand the menu options and
select Preferences.

Dashboard  alsReports ~ Change Module ~ | &

£ BRIDGE RELEASE

Check Positive Pay

# preferences
O Logout
End of Day Cut-Off Time: Tuesday 12:00 PM CDT

Exceptions $0.00 o Click on arrow next to your

name to select Preferences

Set to Pay $0.00 o Set to Return $0.00 (o]

2. Select the appropriate option from the dropdown menus to determine your
default landing page upon login. Note: you do not have to select an option from
each drop down if preferred.
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Preferences
Default Pages
Default Module

- select -

Default Check Positive Pay Page

- default -

Default Dashboard Page

- default -

Save

Dashboard

The Dashboard provides an overview of your daily check activity.

1. Exceptions: by clicking on the amount hyperlink next to “Exceptions” you will be
directed to your list of exceptions. Please see Decision Exception Items for
further instruction on how to manage your exception items.

2. Set to Pay: by clicking on the amount hyperlink next to “Set to Pay”, you will be
directed to a list of all your paid items including items that didn’t create an
exception.

3. Set to Return: by clicking on the amount hyperlink next to “Set to Return”, you
will be directed to a list of all items set to be returned.

Check Posiive Pay

End of Day Cut-Off Time: Friday 12:00 P# CDT
Exceptions § [3]
Sef fo Pay : s ) Se 15 Retuier o

Decision Exception Items

Exception items are created when there is a discrepancy between a check presented to
the bank for payment and the issued items submitted by the company. Once exception
items are created, they are presented for the company users to review and make
decisions to allow legitimate checks to be paid and fraudulent/invalid checks to be
returned.
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When viewing your exception items, the Current Status column will appear with your
defaulted decision defined in your Master Service Agreement (“Pay — System” or
“Return — System”). NOTE:Your items will process according to the Current Status
decision at the systems cutoff time.

1. View the item details by clicking on the *» icon and view the check image by
clicking on the check number.

2. If you wish to change the current status on the item, click on the blue
Pay/Return button under “Change Status.”

Transaction History

Y Filters »

Dateli Change Sustu:
» 3 o

3. If returning, select your return reasoning and click Save.

4. The Current Status will update accordingly and will process the item with this
decision at the systems cutoff time.

Check Positive Pay

Import Issued Items

When a check is issued, it will need to be entered into the system as an issued item. As
the check clears your bank account the system matches this information with what is
presented for payment. If there are any discrepancies the business will be notified of
the exception via email and can choose to pay or return the item within the system.

1. Click on Change Module in the upper right-hand corner of your Dashboard to
select Check Positive Pay.

Check Positive Pay.

End of Day Cut-Off Time: Monday 12:00 PM CDT

2. Expand the Perform menu from the toolbar to select Issue File Load.
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Check Positive Pay ~ ##Manage ~ | #Perform v JiReports v  iEView ~

Issue File Load

Manual Issue Entry
Welcome

Please use the above menu to select an action

3. Select template from drop down. If your file requires a custom template, click on
Create New Template and follow the instructions for creating an issued file
template.

4. Once template is selected, you can drag and drop your file into the box or click
Browse to select the file from the folder search. You can also view the template
format by clicking on View Selected Template.

5. Click on Upload to process the file.

6. The File Status will show progress and let you know if your file was successfully
imported. If you receive any errors please review, update, and save the
information.

7. Verify your total number of checks and dollar amounts. Click on Back to Status
in top right corner to return to the main page. NOTE: Bottom right corner button
will Delete your uploaded file if selected.

< Back to Status 2021 Issued Items for User Guide.xlsx

File Status

Queued Processed Completed Deleted
® View items: 2 Items totaling $8.02 Load Date: 06/09/2021 14:35:18 CDT
Rows 1-2of2.
Account Number Serial Number Amount Payee Name Status Issuance Date
004315 3070 $3.47  Chandler Bing AVAILAELE_FOR_MATCHING 05/31/2021
Maonica Bing
This will delete
xxxd315 30mM $4.55 Central Perk AVAILABLE_FOR_MATCHING 04/30/2021

the uploaded file
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Manual Issue Entry

Users can issue a single or small amount of checks manually.

1. Expand the Perform menu from the Check Positive Pay page and select Manual
Issue Entry.

— -—— — x

L1}
o
1

Check Positive Pay £ Manage ~ # Perform - i Reports ~

Issue File Load
Manual Issue Entry

vveicome

2. Select the appropriate account from drop down.

3. The “Auto populate next check number” box can be checked if you have multiple
checks to enter that are in a sequence.

4. Enter the Serial Number (check number).
5. Enter check Amount.

6. Enter Payee Name. NOTE: The Payee Name field will ONLY appear if your
company has Payee Match.

7. Status will default to Issued. It can be changed to Voided as needed.

8. Issuance Date will default with current date. Click on date within box to modify
as needed.

9. Enter Additional Fields information if this optional feature has been setup for
your company. Please reference Additional Issuance Fields for more information.

10. Continue to add additional checks as needed. Click on Save once all have been
entered.

Manual Issue Entry

cccccccc Auto populate next check number: ()

Row Serial Number Amount Payee Name’ Status Issuance Date

1ssUED 06/21/2021

© Click any row to select that row for editing

BRIDGEWATER BANK - 4450 EXCELSIOR BLVD., SUITE 100 - 8T. LOUIS PARK, MN 55416
952.542.5100- BWBMN.COM

© 2020 Bridgewater Bank. All Rights Reserved.



Issue File Status

You can view, edit, or delete your imported and manually entered issue files.

1. Expand the View menu from the Check Positive Pay page and select Issue File

Status.

E S A L. A e BT AW ¢

Check Positive Pay ¥ Manage - # Perform « i Reports - =Eview «

Issue File Status

I Fil Issue Warehouse
ssuance rilles

Transaction History

= Item Look
Y Filters ey e

2. System will default to the current day’s date. Click on the date to expand date
range if needed. The Filters bar can be expanded to add filters to search.

: Date Range
Issuance Files Status o
&june 1, 2021 - June 30, 2021 ~
Y Filters
Issuance Load ID Status Min Amount
- select status - ~ 3 L ¥
Max Amount it
;
Last Mantk
Apph’ g R | Custom Rang
10

3. Allissued file uploads will appear for both imported files and manually entered

items. They can be viewed or managed by clicking on the available button along
the right-hand side of the list.

4. Within Managed, the file or item can be deleted. Make sure to click on “Back to
Status” in the top left corner to return to list (picture on page 10).

9
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. Date Range
Issuance Files Status d

Ejune 1,2021 - June 30, 2021~
Y Filters >
10 files totaling $134.06
Rows 1-10 of 10,
Issuance LoadID  File Name Status Load Date/Timedf  Transaction Count Transaction Total  View/Manage

> 21388 MANUAL_1623705831558 SYSTEM_APPROVED  06/14/2021 16:23:51 CDT 2 $5.99 e

> 21387 MANUAL_1623705629062 SYSTEM_APPROVED  06/14/2021 16:20:29 CDT 2 5464 Ve

> 21154 2021 Issued Items for File S.xisx SYSTEM_APPROVED ~ 06/11/2021 13:23:25 CDT 4 $20.18 Ve

> 21021 2021 Issued Items for User Guidexlsx  SYSTEM_APPROVED ~ 08/09/2021 14:35:18 CDT 2 $8.02 e

> 20965 MANUAL_1623250062943 SYSTEM_APPROVED  06/09/2021 09:47:42 CDT 1 52.89 Ve

> 20917 2021 Issued Items for File d.xisx SYSTEM_APPROVED ~ 06/08/2021 16:28:43 CDT 5 52547 Ve

> 20916 2021 Issued Items for File 4.xisx DELETED 06/08/2021 16:26:37 CDT 5 $25.47 View

Create an Import Issued Template

Create an import template for quick processing of your positive pay file. Once the template
is established, it will only need to be managed if there are edits to the format.

1. Click on Change Module to select Check Positive Pay in the upper right-hand

corner.

2. Expand the Manage menu to select Issue Templates

3. Click on Create New Template

4. A Create New Template pop-up window will appear. Fill out the fields.
NOTE: If you see a “?” (question mark) place your cursor over it for additional
details about the field.

g.

Fillin Template Name

Select the File Type. NOTE: Fixed Width file types will differ from the
options below as there will be an additional column added to list a Start
and End Position.

The Template Status should remain “Active” to be available for use.
Number of Header Rows: Type the number of rows within your file's
header.

Number of Footer Rows: Type the number of rows within your file's
footer.

Multi-Line Payee Name Separator: Type the separator character into the
box if you have Multiple Payees listed on your checks. Leave blank if you
do not list multiple payees on separate lines. NOTE: If all payees appear
on the check as 1ling, no separator is needed.

Required Mapping Fields:

10
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Serial Number: Type in the column number of the serial (check)
number in your file.

Amount: Type in the column number of the check amount in your
file.

h. Optional Mapping: Check the box to include any of the additional
optional fields to the template or leave the box unchecked if the detail is
not listed in your file.

Vi.

5. Click Save.

Status: Type in the column number of the item’s status in your file.
NOTE: The default of Issue and Void can be changed according to
your file format.

Account Number: Type in the column number of the account
number in your file. NOTE: If the account number is not in your file,
you will be prompted to select the account from a drop down when
uploading.

Issuance Date: Type in the column number of the issued date in
your file.

Payee Name: Type in the column number of the payee name in
your file. NOTE: the payee name will only be saved if Payee Match
is enabled.

Routing Number: Type in the column number of the routing
number in your file.

Additional Information: Additional label options will appear in the
list if Additional Issue Fields have been setup. Please reference
Additional Issue Fields for more information.

Create New Template

Template Name File Type? Template Status

- select file type v Active

Number of Header Rows’ Number of Footer rows’ Template Level’

0 Client

rts| Multi-Line Payee Name Separator:

File Mapping

Add  InputField? File Column? Field Format

Serial Number

Amoun t? @ Fractional Dollars (12.34)
.d] O Whole numbers of cents (1234)
1SSUED - for ISSUED

VOIDED - for VOIDED

Payee Name’

Routing Number?

?- Place the cursor over this label for more information

11
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Edit/Delete an Import Issued Template

A custom issued template can be modified or deleted as needed.

1. Within the Check Positive Pay module, expand the Manage menu to select Issue
Templates.

2. Click on the Edit icon to the right of the template to make changes to the
formatted fields.

3. Update fields as needed.
4. Click Save.
5. To delete a template, Click in the box to the left of them template.

6. Click Delete Selected button at the bottom of the page.

Template File Type
Delete ilter by Template il

Edit/View

Import Ba:

=

=

P4

Delete Selected

Additional Issue Fields

Allows an optional field for additional information to be included with the check when
referencing reports. The system allows for up to 4 rows of additional information which
will be labeled as Client 1, 2, 3, and 4. This information is only captured through items
issued.

1. Within the Check Positive Pay module, expand the Manage menu to select
Additional Issue Fields.

2. Select Client 1 for the first additional field and type the titling of this label.
a. An example, a field could be used for invoice numbers, notes, etc.

12
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Additional Issue Fields

Issue Field’ Label” Delete
Client 1 Notes L}
Client 2 Invoice i)
- Select One- v

€ Click any row to select that row for editing

Save

3. If another label field is needed, select Client 2 and type in the label's title.
Continue process for Client 3 and Client 4 as needed.

4. Click Save.

5. These additional fields will now appear as available options when creating an
Import Issued Template. They will also be available for manual entries of issued
items.

Notes

Manual Issue Entry

Account? Auto populate next check number: C
MAY B DUNN - x0xxd315
Row Serial Number Amount Payee Name’ Status Issuance Date
i ISSUED v | @ 06212021
Notes: Invoice:
6/21/;
1ssUED . 06/21/2021

@ Click any row to select that row for editing

save

View Transaction History

The Transaction History will show all checks that cleared the account.

13
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1. From the Dashboard, click on Change Module in the upper right-hand corner to
select Check Positive Pay.

2. Click on View menu to expand the options and select Transaction History.

3. You will see all presented transactions for the current day. Any exception items
will have a red circle with an exclamation point. The Date Range can be filtered
by clicking on the date in the upper right-hand corner.

4. Clicking Filters on the left-hand side of the toolbar will provide additional
options to search and sort by. Click Apply after selecting your criteria. NOTE:
Leaving a blank field will not filter the criteria and show all items.

a.

® o000

Transaction History

T Filters

Account”

Min Amount

Max Amount

Account — Select for a specific account
Min & Max Amount — Select an amount range
Serial Number — Enter a specific check number (serial number)
Serial Number Range - Select a range of check numbers (serial numbers)
Exceptions:
i. All Transactions — All checks that cleared
ii. Exception Only Items — Checks presented for payment that
created a discrepancy when matching to the issued information
iii. No Exception Items — Checks presented for payment that matche
the issued information
[tems — Any Items (only option available)
Transaction Status — Allows you to view exception items based on how
they were decisioned

d

i. NOTE: Multiple statuses can be selected by holding the “CTRL" key

down while clicking on the status options.

Date Range
nay 28, 2021 -
v
Serial Number ltems

Serial Number Range Transaction Status
Min Serial Num Max Serial Num Pay
Y

Exceptions

v Al Tr

5. Toview the transaction details, expand the item by clicking on the arrow.

6. To the check image, click on the Serial Number
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N : Drate Range
Transaction History :

WMay 28, 2021 -
¥ Filters >
Transaction ID Account Number Serial Number Credit  Debit Current Status Dateli Change Status ceptio
. @ray o
: ‘

7. The check image will appear in a pop-up window showing the front and back of
check.

8. Click Close to return to the Transaction History screen of exceptions.

Issue Warehouse

All issued items can be viewed in the Issue Warehouse. This includes all issued and
voided items that have cleared or have not been presented for payment.

1. Within the Check Positive Pay module, expand the View menu to select Issue
Warehouse.

2. System will default to the current day’s date. Click on the date to expand date
range if needed.

3. Clicking on Filters on the left-hand side of the toolbar will provide additional
options to search and sort by. Click Apply after selecting your criteria. NOTE:
Leaving a blank field will not filter the criteria and show all items.

a. Account — Select for a specific account
b. Min & Max Amount — Select an amount range
c. lIssue Type:
i. Issued — All issued checks
ii. Void — All voided checks
iii. Stopped — Not Applicable

d. Serial Number — Enter a specific check number (serial number)
e. Serial Number Range - Select a range of check numbers (serial numbers)
f. Match Status:
i. Paid — All checks that were paid
15
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ii. Returned — All checks that were returned
iii. Outstanding — All checks that haven’t been presented for payment

Date Range Filter Type:

i. Issue Date — Filters checks by the issued date reflected in the

issuance information

ii. Load Date — Filters check by the date the issuance information
was imported or entered into the system
Additional Issue Fields — Optional information field that can be included
in your issuance file. Please see Additional Issue Fields for more

information.
Click Apply

Issue Warehouse

Y Filters

Account?

- not selected -

Min Amount

$

Max Amount

$

Issue Type

- select issue type -

Serial Number

Serial Number Range

Min Serial Num Max Serial Num

Match Status

- select match status type -

4. Issued items will appear in list.

Date Range
&july 13, 2021~
v

Date Range Filter Type

Issue Date ® Load Date

Additional Issue Fields

Notes Invoice

5. Click on ? (arrow) icon located to the left of the item to expand more
information on the item.

6. A pencil will show on right-hand side of item if editing is allowed.

7. Ifa

appears to the right of the item, the item was presented; therefore, the
item can no longer be edited.
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Item ID

w 4638913

Status

VOIDED

> 4s33912

> 4838911

> 4638910

> 4626800

Account Number

X04315

Payee

JOHN DOE

004315

WO4315

00xA315

004315

Serial Number  Payee Name Issue Type
5415 JOHN DOE VOIDED
Amount Issue Date
$2.85 03/31/2021
7412 JANE DOE VOIDED
9632 VOID TEST VOIDED
asn TEST ISSUED
3173 |ack & Judy Geller  ISSUED

Ross Geller

Match Status

QUTSTANDING

Updated By

202 1MEKjome

QUTSTANDING

OUTSTANDING

OUTSTANDING

PAl

o

Amount

$2.85

$3.14

$2.10

$2.54

$5.99

Load Date/Timel

06/14/2021 16:23:51 CDT

Updated Date/Time

05/14/2021 16:23:51 COT

06/14/2021 16:23:51 COT
06/14/2021 16:20:29 COT
06/14/2021 16:20:29 COT

06/11/2021 13:23:25 COT

Issuance Date

05/31/2021

06/01/2021

06/10/2021

Update

2

8. The issued items can be exported as a CSV file by clicking on the “Download As
CSV” button at the bottom of the list.

Item Lookup

You can view an item for additional check or issuance detail.

1. Within the Check Positive Pay module, expand the View menu to select Item
Lookup.

2. Select an Account and enter a Serial Number (check number). NOTE:Both fields
are required.

3. Click Apply.

4. The check information will appear.
a. If the item has been presented, the check image will be available to view
and the transaction information will be listed.

b. If item has not been presented but has been issued, the issued
information will appear with an OUTSTANDING status.

Item Lookup

Account’ Serial Number
MAY B DUNN - 300¢x4315 (BRIDGE RELEASE - 2021) b 3063
Apply
Account Number: xxxx4315 Serial Number: 3063
Issuance Date: 05/31/2021 Update By: Payee Name: Jack & Judy Geller

Ross Gell
Updated Date/Time; 06/08/2021 16:28:44 CDT  Issue Type: ISSUED 055 Geller

Match Status: OUTSTANDING
Load Date/Time: 06/08/2021 16:28:44 CDT

Amount: $6.72

17
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Item Lookup

Account? Serial Number

MAY B DUNN - xxx4315 (BRIDGE RELEASE - 2021) v 3051

Apply

Account Number: x00xx4315 Serial Number: 3051 View Check Image

Transaction Date: 06-04-2021 Original Serial Number: 3051 Exception Reason: Payee Discrepancy

Payment Date: 06-02-2021 Original Amount: $3.44 Payee Match Score: 0

Transaction ID: Issuance Payee Name: Central Perk Disposition Created: 06/04/2021 12:00:00 CDT
Gunther

Debit Amount: $3.44

Issuance Serial Number: 3051
Current Status: Pay-System -

Issuance Amount: $3.44

Issuance Status: ISSUED

Issuance Date: 04/30/2021 Update By: Payee Name: Central Perk

Gunti
Updated Date/Time: 06/02/2021 14:00:54 COT  Transaction Id: unther

Match Status: PAID
Load Date/Time: 06/02/2021 14:00:54 CDT Issue Type: ISSUED

Amount: $3.44

Reports

Check Positive Pay Module Report — Issue Item Status

Within Check Positive Pay, the Issue Item Status Report shows an item and its current
status of Outstanding, Paid, Returned or Stopped.

1. Select Issue Item Status from the Report menu.

2. Select appropriate Issue Item Status:
a. Outstanding —All transactions with an outstanding status will appear.
b. Paid — All checks that were paid
c. Returned — All checks returned
d. Stops/Voids — All voided checks
i. NOTE:The Start Date will default the current day’s date and will
need to be changed before viewing paid, returned, or voided items.

3. If you have access to multiple accounts, a drop down will be available for
Account. This can be left on “-not-selected-"“to view all paid items on all
accounts or you can select an account to view paid items for the specific
account.

4. Click Apply

Issue Item Status

Issue Item Status

Issuance Status Start Date End Date
-] & 07/12/2021
* Outstanding
Fald Summary Information Only Account?
Returned
- not selected -
Stops/Voids i SN
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Report can be downloaded as a CSV file by clicking on the “Download As CSV”
button.

Dashboard Module Reports — Audit & Notification of
Delivery

1. Click on Reports from the Dashboard page to select a reporting option.

a. Audit Report: Provides audit history of each user.
i. By clicking on the arrow for the line item, it will expand more
details. The filters bar can be expanded to filter the list by User or
Product.

b. Notification Delivery Report: Provides history of notifications delivered
to each user.
i. The line item can be expanded for more details by clicking on the
arrow. The filters bar can be expanded to filter the list by
Recipient, Message Type, or Status.

2. The date will default to current date, but it can be clicked on to select a different
date.

NOTE: Both reports can be downloaded as a CSV file by click on the button at the
bottom.

19
BRIDGEWATER BANK - 4450 EXCELSIOR BLVD., SUITE 100 - 8T. LOUIS PARK, MN 55416

952.542.5100- BWBMN.COM

© 2020 Bridgewater Bank. All Rights Reserved.



	General Information
	General Information
	Access Check Positive Pay
	Check Positive Pay can be accessed via The Bridge’s Secure Browser.
	Check Positive Pay can be accessed via The Bridge’s Secure Browser.
	User Preferences
	Preferences is an optional feature that allows you to choose your preferred default landing page to provide quicker access to complete your daily tasks.
	Dashboard
	The Dashboard provides an overview of your daily check activity.
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	Exception items are created when there is a discrepancy between a check presented to the bank for payment and the issued items submitted by the company. Once exception items are created, they are presented for the company users to review and make deci...
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	When a check is issued, it will need to be entered into the system as an issued item. As the check clears your bank account the system matches this information with what is presented for payment. If there are any discrepancies the business will be not...
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